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ABSTRACT 

 

Multiple Sclerosis (MS) is chronic disease which affects mainly the brain and the spinal cord. 

Even with today’s medical advancements it is very hard to diagnose and offer a specific 

treatment because on each individual patient MS strikes atypically, hence the numerous 

symptoms, both physical and mental. 

In order to diagnose MS, a Magnetic Resonance Imaging (MRI) scan is necessary to identify the 

lesions created in the patient’s brain. MRI is also vital for the treatment of MS where the 

patient’s progress is monitored and the treatment is adjusted on each iteration. 

Each individual MRI is almost unique in the way they are captured, not just their content. MRI is 

a 3D image which if you were to match with other images you’d have to first align them 

correctly and efficiently. 

A tool that has a potential to do just that or even more is LONI PIPELINE. The user has to build 

workflows, from the most basic ones to the most complicated reflecting the problem he is trying 

to solve. Thru the usage of LONI Pipeline and the help of sample workflows that we run with 

datasets we might extract some results in order to analyze and reach certain conclusions to the 

MS progression. 
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Chapter 1 

 

Introduction 

 

 

1.1 Motivation          

1.2 Thesis Structure         

 

 

1.1 Motivation 

The human brain, it’s a complicated as it is fascinating. It is much more than an organ, it is 

capable of producing enormous processing power, without us even noticing. 

Never the less the brain is physical part of our body, an organ that as any other we have to take 

care so that it can take care us. Not just us individuals bus all of the human species, we must 

unlock its secrets for better healthier future  

This thesis aims to study workflows for MRI analysis for the above reason. By using computing 

power from artificial ways we get to understand and improve our human processors. 

How by taking “images” of our brain which is a fascinating idea by itself we can monitor 

diseases and functions of the brain we can study the effects of these diseases and provide 

hopefully someday treatment with the final goal to eradicate these diseases  
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1.2 Thesis Structure 

 

This particular thesis will follow the structure below: 

 

Chapter 2: Basic information and terminology about different parts, substances and functions of 

the human body. 

 2.1 Central Nervous System         

2.2  The Brain 

2.3 The Spinal Cord  

2.4  The Spine 

2.5  Brain Cells 

2.6  Myelin sheath 

2.7  Blood Brain Barrier 

2.8  T Cell  

2.9 B Cell 

 

Chapter 3: in depth view of the Multiple Sclerosis disease  

 3.1 Multiple Sclerosis         

3.2  Symptoms  

3.3 Types of Multiple Sclerosis 

3.4 Pathophysiology 

 

Chapter 4: Magnetic Resonance Imaging 

 4.1 Magnetic Resonance Imaging  

4.2 History of Magnetic Resonance Imaging 

4.3 Magnetic Resonance Imaging Function 

 

Chapter 6: Workflows of LONI Pipeline 

 6.1  Introduction 

6.2 Basic Workflows  
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6.3 Constructed Workflows 

 

APPENDIX A: The LONI Pipeline tool 

 A.1  Introduction 

A.2 Installation 

A.3 Interface Overview 

A.4 Workflow Building 

A.5 Execution 
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CHAPTER 2 

 

Background and Terminology 

 

2.1 Central Nervous System         

2.2  The Brain 

2.3 The Spinal Cord  

2.4  The Spine 

2.5  Brain Cells 

2.6  Myelin sheath 

2.7  Blood Brain Barrier 

2.8  T Cell  

2.9 B Cell 

 

 
 
For a better understanding of Multiple Sclerosis and the whole spectrum around this subject, we 
have to first and foremost understand some basic terminology around the body functions, the 
brain and neurology. 
 

2.1 Central Nervous System 

Therefore, it is important to explain about the most crucial organ of the body, the Central 
Nervous System or CNS. CNS is consisted by the brain which is a complex organ that defines 
each one of us individually, from our basic movement, our perception of our surroundings. 
Importantly, the brain is the organ that defines our character. With that in mind, the spinal cord 
is the other part of CNS which its main duty is to send messages from the brain to different parts 
of the body and to receive messages back. 
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Fig 1 A side view of the brain and it's sections. [1] 

 

2.2 The Brain 

It is for the most part an unconditional fact that the brain is considered the “body’s control 
center” since, “it constantly receives and interprets nerve signals from the body sensors and 
sends new signals based on this information” [1]. Moreover, different parts of the brain are 
focused on different functions such as; control movement, speech, emotions, consciousness 
and internal body functions, such as heart rate, breathing and body temperature. 
The brain can be divided in three main parts, including Cerebrum, Brain stem and 

Cerebellum. 
 

2.2.1 Cerebrum 

 

That said, the Cerebrum is the largest part of the brain. It is divided into 2 hemispheres called 

the left and right cerebral hemispheres. Furthermore, the right half of the cerebrum or the right 

hemisphere, is the hemisphere which is responsible for controlling the left side of the body. In 

contrast, the left hemisphere is responsible for the right side of the body. In fact, these two 

hemisphere “are connected by a bridge of nerve fibers called the corpus callosum” [1]. Hence, 

the left and the right hemispheres are in charge of the whole body movement related functions. 

The cerebral cortex also referred to as the grey matter “is the outer, folded part of the brain” [1]. 

In order to understand the functionality of the cerebral cortex, it is important to explain another 

component of the brain, the cell bodies and dendrites of nerve cells (neurons). That is the case 

since, “cell bodies contain the nucleus and other main parts of the cell. Dendrites are the short 

branching fibers that receive signals from other nerve cells” [1]. The cerebrum also consists of 

white matter which is the inner part of the cerebrum. White matter “is mostly made up of the 

long fibers of a nerve cell (called axons) that send signals to and from the brain to the rest of the 
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body. The fatty coating that surrounds axons (called myelin) gives this part of the brain a whitish 

appearance” [1]. 

 

 
Fig 2 A side view of the brain and its lobes.[1] 

 

Each brain hemisphere is divided into four sections called lobes. These lobes are the frontal, 

parietal, temporal and occipital lobes and each lobe has different functions: 

• The frontal lobe: “controls movement, speech, behavior, memory, emotions and intellectual 

functions, such as thought processes, reasoning, problem solving, decision-making and 

planning” [1]. 

• The parietal lobe: “controls sensations, such as touch, pressure, pain and temperature. It also 

controls the understanding of size, shape and direction (called spatial orientation)” [1]. 

• The temporal lobe:” controls hearing, memory and emotions. The dominant (left side in most 

right-handed people) temporal lobe also controls speech” [1]. 

• The occipital lobe that controls vision. 
 

 

2.2.2 Brain Stem 

Brain stem is the accumulation of the nerve tissue which is located at the base of the brain. 

Importantly, the task of the brain stem is to connect the cerebrum and cerebellum to the spinal 

cord. Therefore, the brain stem sends information to and from the other parts of the brain to the 

rest of the body and thus, it controls breathing, body temperature, blood pressure, heart rate, 

hunger, thirst and digestion of food. 

The brain stem also is consisted by three areas which are: 

• midbrain (also called the mesencephalon) 

• pons 

• medulla oblongata 
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2.2.3 Cerebellum 

Cerebellum is another part of the brain which is “located under the cerebrum at the back of the 

brain” [1]. likewise, as the other three main part of the brain. Cerebellum is divided yet again 

into two hemispheres and it also has grey and white matter. 

The main responsible of the cerebellum is precisely to control functions such as: 

• movement 

• posture 

• balance 

• reflexes 

• complex actions (like walking and talking) 

• collecting sensory information from the body 

  

2.3 Spinal Cord 

 

Spinal Cord is the other main component of CNS and it is responsible for the fast transition of 

responses from and to the brain and the rest of the body. To be more precise, the spinal cord is “a 

thick column of nerves surrounded by vertebrae that runs from the brain stem to the lumbar 

region of the spine” [1]. Likewise, the spinal cord is similar to the brain since both of them have 

grey and white matter. 

Along the spine, spinal nerves exit the vertebrae in pairs at the lumbar region, the spinal cord 

branches into a group of spinal nerves that exit the lumbar vertebrae and sacrum. The spinal 

nerves control body functions like movement, bladder and bowel control and breathing. The 

spinal nerves are numbered after nearby vertebrae. 

 

 

2.4 The Spine  

Having discussed about the spinal cord, it is crucial to discuss about the spine and its functions. 
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Fig 3 A cross section of the vertebrae. [1] 

 

With that in mind, the spine is consisted of twenty-six bones that are responsible to surround and 

protect the spinal cord. Moreover, this collection of bones is divided into five sections which 

includes twenty-four vertebrae. To be more precise, the five sections are classified into cervical, 

thoracic and lumbar regions, the sacrum and the coccyx [1]. More precisely they are: 

• Cervical region – These are 7 vertebrae at the top of the spine that run from the base of 

the skull to the lowest part of the neck. 

• Thoracic region – These are 12 vertebrae that run from the shoulders to the middle of the 

back. 

• Lumbar region – These are 5 vertebrae that run from the middle of the back to the hips. 

• Sacrum – This is a large section of fused vertebrae at the base of the spine. 

• Coccyx (tail bone) – This is a small, thin section of fused vertebrae at the end of the 

spine. 

• Between the vertebrae are the discs (intervertebral discs). A layer of cartilage found 

between the vertebrae. Discs cushion and protect the vertebrae and spinal cord. 
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Fig 4 The spine and it’s sections.[2] 

 

2.5 Brain Cells 

It is important to note that, the brain’s two main types of cells are the Nerve cells and Glial cells. 

 

 
Fig 5 The structure of the Neuron. [1] 

 

2.5.1 Nerve cells 

Nerve cells (neurons): these are the cells that carry the electrical signals in order to make the 

nervous system work. In fact, the nerve cells are the longest cells in the body and in the event of 

any sort of damage they cannot be replaced or repaired. 

 

2.5.2 Glial Cells 

Glial cells (neuroglial cells): these are the cells that support, feed and protect the nerve cells. The 

different types of glial cells are: 

• astrocytes 
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• oligodendrocytes 

• ependymal cells 

• microglial cells 

 

2.6 Myelin sheath  

Myelin is mainly a fatty material that covers, shields, and secures the axon of some nerve cells. 

Importantly, Myelin is enables the nerve cells to quickly conduct impulses between the brain and 

different parts of the body. Moreover, “Myelin coats the nerves of both the central nervous 

system and the peripheral nervous system” [2]. That said, Myelin encompasses proteins that the 

immune system takes advantage from. Therefore, a variety of symptoms of multiple sclerosis are 

being provoked through this corrosion of the Myelin in the central nervous system. 

 

In contrast with the unmyelinated fibers in which the impulses persistently move as waves, the 

myelin coated nerves propagate the impulses by the saltatory conduction. Furthermore, Myelin 

coated nerve cells have tiny spaces between the sections which are also known as nodes. During 

the event where the brain sends messages in the form of impulses through the nerves of the 

spinal cord then, these impulses jump from one node to another. Another function that needs to 

be mentioned is no other than the myelin sheath, which is responsible for preventing these 

impulses from breaking away from the nerve at the wrong point. 

Myelin is composed by a diverse collection of chemical compositions and arrangements of 

different cell types. Having said that, the term white matter of the brain derives from myelinated 

axons which are white. Moreover, “Myelin insulates axons from electrically charged atoms and 

molecules” [8]. In addition, Myelin not only increases the speed of the nerve impulse but also it 

“helps in reducing energy expenditure over the axon membrane as a whole” [4]. That is the case 

since, “the amount of sodium and potassium ions that need to be pumped to bring the 

concentrations back to the resting state following each action potential is decreased” [4]. 
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Fig 6 Cross section of a myelinated axon [3] 

1. Axon, 

 2. Nucleus of Schwann Cell,  

3. Schwann Cell,  

4. Myelin Sheath, 

5. Neurilemma 

2.7 Blood-Brain Barrier 

 

The blood-brain barrier (BBB) “is a highly selective semipermeable membrane barrier that 

separates the circulating blood from the brain and extracellular fluid in the central nervous 

system” [5]. Significantly, the BBB’s main purpose is to limit the majority of substances, found 

in the blood, from slipping into the brain. BBB can also help sustain a steady environment in 

order for the nerve cells to function properly in the brain [1]. 
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Fig 7 The Blood Brain Barrier, at different locations of the brain.[4[ 

 

In a more detailed analysis, “the BBB is made up of very small blood vessels that are lined with 

thin, flat endothelial cells” [1].  In contrast with other parts of the body the endothelial cells have 

narrow gaps between them in order to permit substances to travel in and out of the capillary. That 

said, it is through these narrow gaps that the blood can reach other cells and tissues. Nonetheless, 

the endothelial cells in the brain are tightly compressed together, so no substances can pass out 

from the bloodstream into the brain [1]. 
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Fig 8 A cros section of a Normal Blood Vessels and the vessels at the Blood Brain Barrier.[5] 

 

2.8 T Cell 

 
T cell is a subtype of white blood cell, also known as lymphocyte, and it is crucially important for 
the immune system. More specifically, the T cell is the one responsible for adapting the body’s 
immune system. Moreover, one of the main tasks of the T cells is to “search out and destroy the 
targeted invaders” [5]. 
 
Immature T cells drift to the thymus gland which is located in the neck area, where they 
eventually mature and transform into various types of T cells. Moreover, due to the effect of the 
hormone called thymosin and other factors these T cells are being activated in the immune 
system. Hence, normally during this maturational process the T-cells that are being potentially 
stimulated against the organism’s own tissues are killed or modified. It is important to note that 
there are several different types of mature T cells. However, not all of the functions of those 
mature cells are known. To give an example, some T cells can “produce substances called 
cytokines such as the interleukins which further stimulate the immune response” [5]. All things 
considered, it is crucial to mention that the term T cell is also referred as T lymphocytes and the 
T stands for thymus. In comparison with the B cells in which the cells mature in the bone 
marrow, the T cell mature in the thymus. 
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Fig 9 T Cell matuaring. 

 
 

2.9 B Cell 

 
B cell: B cells “are a type of white blood cell of the lymphocyte subtype” [7] that mature into 

plasma cells and memory cells. More specifically, B cells “produce antibodies (proteins) 

necessary to fight off infections while other B cells mature into memory B cells” [6].  

 
All of the B cells that become plasma cells derive from a single B cell which produces the same 
antibody that is guided against the antigen that stimulated it to mature. Likewise, plasma cells 
function in the same way with memory B cells and thus, all of the plasma cells and memory cells 
learn the stimulus that prompt their formation. Hence, the B cells are important cells for the 
immune system. Last but not least, the B cells are in charge for the production of 
immunoglobulins and due to the fact that the B cells are not thymus-dependent, they have a 
narrower lifespan. 
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Fig 10 B Cells basic function.[7] 
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CHAPTER 3 

 

Multiple Sclerosis 

 

 

3.1 Multiple Sclerosis         

3.2  Symptoms  

3.3 Types of Multiple Sclerosis 

3.4 Pathophysiology 

 

 

 

3.1 Multiple Sclerosis 

 

Multiple sclerosis or as is often referred to as MS, is a chronic disease that the variety 

of individuals get diagnosed with. To be more precise, MS primarily affects the brain, spinal 

cord and the optic nerves of the patient's eyes and thus, it can cause extensive problems on the 

patient’s muscle control, vision, balance and various other organs or function related with basic 

body functions. Therefore, in order to improve the treatments concerning MS, there is a great 

need to examine it thoroughly. With that in mind, “multiple sclerosis is a demyelinating disease 

in which the insulating covers of nerve cells in the brain and spinal cord are damaged” [9]. 

Having said that, the result damage of the brain and the spinal cord intervenes and disturbs the 

proper communication and function of the nervous system. Through this lack of communication 

of the nervous system a diverse mixture of symptoms and signs emerge indicating mental, 

physical and sometimes psychiatric issues. 

 

“MS takes several forms, with new symptoms either occurring in isolated attacks (relapsing 

orms) or building up over time (progressive forms)” [11]. In other words, the disease’s effects 

vary on different occasions of patients, from very mild symptoms that do not require any 

treatment to patients that find it really difficult to move around or do basic human body 

functions. Hence, most of the time MS patients require extensive help and monitoring. One may 

argue that, due to the fact that the symptoms of MS can vary depending on each individual, each 

patient with MS lives with a different illness. Thus, the complexity of this particular illness relies 

on the fact that the pattern is unique for everyone. However, nerve damage is always a part of the 

disease. 
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Fig 11 MRI of a brain with MS lesions.[8]  

3.2  Symptoms  

 

Due to the fact that the nerves do not work properly the patient may experience symptoms such 

as: 

· Trouble walking 

· Feeling tired 

· Muscle weakness 

· Muscle spasms 

· Blurred vision 

· Double vision 

· Numbness and tingling 

· Sexual problems 

· Poor bladder 

· Bowel control 

· Pain 

 

3.3 Types of Multiple Sclerosis 

 

Importantly, the field of medicine managed to identify some primary types of MS. Moreover, the 

importance of these categories relies on the fact that they can contribute to a better understanding 

of how severe this disease can be and predict how well the treatment will work. 

 

3.3.1 Relapsing-Remitting Multiple Sclerosis (RRMS) 

 

One of the types of MS is Relapsing-Remitting Multiple Sclerosis. That said, it is important to 

note that the majority of people who are diagnosed with MS they often show symptoms of the 

disease in the range of the ages between twenty and forty. More specifically, usually the 

symptoms can be described as sporadic attacks, also known as relapses. With that in mind, most 

of the time these sporadic attacks are followed by a recovery period which is also referred to as 
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remissions. In other words, in this type of MS, when some of the sporadic attacks occur, they are 

being succeeded by weeks, months, or years of remissions.” The nerves that are affected, how 

severe attacks are, the degree of recovery, and the time between relapses all vary widely from 

person to person and eventually, most people with relapsing-remitting MS will move on to a 

secondary progressive phase” [12]. 

 

3.3.2 Primary Progressive Multiple Sclerosis (PPMS) 

 

PPMS depicts when the disease aggravates on a gradual level through time. “There are no well-

defined attacks of symptoms, and there is little or no recovery” [12]. Significantly, the treatments 

of this kind of MS, PPMS, tend to not have the required results. Furthermore, this particular type 

of MS is much rarer since, “about 10% of people with MS have this type” [12]. 

 

 The main differences between PPMS and the other kinds of MS include: 

 

• “People with primary progressive MS are usually older when they’re diagnosed - an 

average age of 40”. 

• “Roughly equal numbers of men and women get it. In other types of the disease, women 

outnumber men 3 to 1”. 

• “It usually leads to disability earlier than the most common type, relapsing-remitting MS” 

[12]. 

 

3.3.3 Secondary Progressive Multiple Sclerosis (SPMS) 

 

Patients are frequently diagnosed with SPMS when they move from the RRMS phase and it 

often appears around ten to twenty years after RRMS is diagnosed. In fact, through the SPMS 

phase the symptoms tend to increase in a steady pace. However, in some instances the relapses 

and remissions tend to decrease. Thus, even though it’s somewhat unclear why the disease makes 

this shift, some scientists claim to have understood some things about this particular process: 

 

• “The older a person is when he’s/she’s first diagnosed, the shorter the time he/she has 

before the disease becomes secondary progressive”. 

• “People who don’t fully recover from relapses generally move to secondary progressive 

MS sooner than those who do”. 

• “The process of ongoing nerve damage changes. After the transformation, there's less 

inflammation and more of a slow decline in how well the nerves work” [12]. 

 

SPMS is significantly harder to treat and patients are more likely to struggle with everyday tasks 

as they become harder to perform. More specifically, the symptoms in the SPMS phase tend to 

aggravate however, the degree of the symptom’s intensity differs from one patient to another. 

Hence, even though the treatments work somewhat sufficiently, most of the patients will 

probably experience difficulties to utilize their body in the same way they used to. 

 

3.3.4 Progressive Relapsing Multiple Sclerosis (PRMS) 

 



 

 

19 

 

Through the PRMS phase the relapses or attacks happen more frequently. However, the 

symptoms of MS do not cease to continue and in fact, in some cases the symptoms get worse. 

Furthermore, “this type is the rarest form of MS, it is so rare that doctors don’t know much about 

it. Probably around 5% of people with multiple sclerosis have this form. In many ways, it seems 

similar to primary progressive MS” [12]. 

 

 
Fig 12 Chart of the types of MS disability according to time[9] 

 

3.4 Pathophysiology 

 

All things considered, MS occurs when the immune system attacks the myelin. To be more 

precise, the myelin protects and surrounds the neurons’ axons since, the myelin allows the quick 

propagation of electrical impulses. With that in mind, myelin is produced by oligodendrocytes, 

which are a group of cells that support neurons. Furthermore, in MS, demyelination happens 

when the immune system inappropriately attacks and destroys the myelin, which makes 

communication between neurons break down. This ultimately leads to all sorts of sensory, motor, 

and cognitive problems resulting to the above mentioned symptoms. 
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Fig 13 Healthy myelin vs damaged from MS.[10] 

 

The neurons in the brain are protected by the blood brain barrier (BBB), which only lets certain 

molecules and cells through BBB and from the blood. Moreover, for immune cells like T and B 

cells this access means having the right surface molecule to get through the blood brain barrier. 

However, in the case of multiple sclerosis once a T cell makes its way in it can get activated by 

the myelin. Then, once the T-cell gets activated, it changes the blood brain barrier cells to 

express more receptors and thus, this allows the immune cells to bind and get in more easily. 

 

 Multiple sclerosis is a type IV hypersensitivity reaction, or cell-mediated hypersensitivity which 

means that those myelin specific T-cells release cytokines like IL-1, IL-6, TNF-alpha, and 

interferon-gamma. All these cytokines dilate the blood vessels which allow more immune cells 

to get in, as well as directly cause damage to the oligodendrocytes. Moreover, the cytokines also 

attract B-cells and macrophages as part of the inflammatory reaction. Those B-cells begin to 

make antibodies that mark the myelin sheath proteins and then, the macrophages use those 

antibody markers to absorb and destroy the oligodendrocytes. 

 

Importantly, without oligodendrocytes there is no myelin to cover the neurons and this leaves 

behind areas of scar tissue, also called plaques or sclera. In multiple sclerosis, these immune 

attacks typically happen in sessions where an autoimmune attacks on the oligodendrocytes. In 

the event in which this happens the regulatory T cells will come in to inhibit or calm down the 

other immune cells, leading to a reduction in the inflammation. Early on in multiple sclerosis, the 

oligodendrocytes will heal and extend out new myelin to cover the neurons, which is a process 

called remyelination. Although over time as the oligodendrocytes die off the remyelination stops 

and the damage becomes irreversible with the loss of axons. 

 

When the myelin is lost due to the T cell attack, it leaves a scar tissue at multiple areas. 

Therefore, when this scar tissue hardens is called sclerosis. Furthermore, the ability for the 

nerves to transmit messages, is due to the fact that the myelin sheath has been damaged. In other 
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words, these destroyed areas are also referred to as plaques. Thus, these plaques can be 

recognized through a magnetic resonance imaging (MRI). more specifically, the MRI is a 

technique that aids the doctors to observe and review thoroughly the progress of MS and hence, 

act accordingly. 

 
Fig 14 Healthy Nerve  vs Nerve affected by MS.[11] 

  

Other important symptoms of MS do not only concern physical problems but also, mental 

symptoms as well. In other words, it is quite often that the patient may encounter mental 

symptoms including mood symptoms and cognitive impairment. Moreover, people diagnosed 

with MS appear to have a higher number of psychiatric symptoms such as depression and 

anxiety due to functional status and way of life. In fact, the lives of MS patients can be affected 

by psychiatric disorders in a variety of ways. 

 

The most notorious symptom and outcome of MS is depression. Significantly, the patients with 

depression often appear to have cognitive difficulties, including memory complaints. One may 

argue that, the patients experience high levels of stress or tough situations might have tendencies 

of depression. Therefore, it is quite apparent how the long-term physical symptoms of MS can 

result to changes in a patient’s mood. Nonetheless, depression may be the result of MS on itself. 

That is the case since, MS distracts the protective coating surrounding the axon of the nerves 

which aids the brain to send signals that affect mood. Last but not least, “depression is also a side 

effect of some the drugs that are prescribed to treat MS, such as steroids and interferon.” [13]  

 

It is still somewhat of a mystery in the field of medicine what are the causes of MS however, it is 

considered by many to be linked to both genetic and environmental factors. Nonetheless, there 

are many things that seem to make the disease more likely. Moreover, some individuals who 

carry specific genes tend to have a higher risk on getting MS. The individuals with the higher 

chances of getting MS are primarily women and those having genes that contain a specific type 

of immune molecule called HLA-DR2. To be more precise, the immune molecule called HLA-

DR2 is used to identify and bind to foreign molecules. Additionally, environmental risk factors 

might include infections as well as the lack of vitamin D. Thus, both the genetic and 

environmental factors may stimulate the body to not kill immune cells target myelin. Finally, 

another factor that may raise the risks of getting MS is smoking. 
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In some cases, some individuals might get MS as a result of getting a viral infection. That is the 

case since, when a viral infection occurs in the body the immune system fails to work properly. 

In addition, infections may generate or cause relapses. Even though, a variety of scientific 

studies have been made in order to find a link between MS and viruses, the answer still remains 

unclear.  

 

Some scientific studies indicate that vitamin D, which is acquired through sun exposure, may 

lead to the strengthening and protection of the immune system. Furthermore, the 

individuals have lower chances of getting the disease who move to sunnier regions like the 

equator where there’s a lot more sunlight compared to places with little or minimal sunlight like 

the northern and southern poles. 

 

In regards with the treatment of MS, there is not a main cure. However, there are some specific 

medications which are effective for the relapsing-remitting type. That is the case since, these 

particular medications like corticosteroids, cyclophosphamide which is a cell cycle inhibitor, and 

intravenous immunoglobulin tend to help blunt the autoimmune process. Not only that, 

plasmapheresis can have similar effects since plasmapheresis is when the plasma is filtered to 

remove disease-causing autoantibodies. 

 

The chronic treatment for MS contains immunosuppressants like recombinant beta-IFN which 

tend to reduce the level of inflammatory cytokines in the brain. Moreover, immunosuppressants 

are considered to raise the functionality of T regulatory cells. That said, some other 

immunosuppressants tend in actuality to stop T cells from passing into the brain. That is the case 

since, these immunosuppressants interfere with the T cell’s surface molecules since, in the case 

of MS they used to gain passage through the blood brain barrier. 

 

 Unfortunately, though, a few treatment options are available for the development of MS. 

Instead, treatments are often provided to limit specific symptoms, ranging from depression to 

bladder dysfunction. Additionally, it is known that physical therapy and cognitive rehabilitation 

therapy may result to be particularly helpful with sensory, motor, and cognitive symptoms. All 

things considered, in regards with the treatment of MS there is an increasing interest in the role 

of vitamin D as an effective treatment. 
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CHAPTER 4 

 

Magnetic Resonance Imaging  

 

 

4.1 Magnetic Resonance Imaging  

4.2 History of Magnetic Resonance Imaging 

4.3 Magnetic Resonance Imaging Function 

 

 

 

4.1 Magnetic Resonance Imaging  

The Magnetic Resonance Imaging (MRI) was initially called 'NMRI' (nuclear magnetic 

resonance imaging). That said, MRI is common test or procedure in medical technology, where it 

is used daily for medical conditions diagnosis [18]. To be more precise, an MRI scanner utilizes 

radio waves and magnetism in order to generate a 3D image of the human or animal anatomy. 

Therefore, it is used for looking inside the body without using surgery, harmful dyes or x-rays, 

making it painless and harmless to the patient.  

MRI “uses a very powerful magnetic field, radio frequency pulses and a computer to produce 

detailed pictures of organs, soft tissues, bone and virtually all other internal body structures of 

the person that is taking the test” [19]. Therefore, it is for the most part an unconditional fact that 

the detailed MR images are important in the process of determining the presence of a certain 

disease.  

MRI of the body is used to evaluate: 

• organs of the chest and abdomen such as the heart, liver, etc. 

• pelvic organs such as the bladder and the reproductive organs. 

• blood vessels. 

• lymph nodes [19]. 

MRI is also being used to diagnose, examine or monitor treatments for a variety of conditions 

such as: 

• tumors of the chest, abdomen or pelvis. 

• diseases of the liver, such as cirrhosis, and abnormalities of the bile ducts and pancreas. 

https://www.thoughtco.com/x-ray-1992692
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• inflammatory bowel disease such as Crohn’s disease and ulcerative colitis. 

• heart problems, such as congenital heart disease. 

• malformations of the blood vessels and inflammation of the vessels. 

• a fetus in the womb of a pregnant woman [19]. 

 

 

 
Fig 15. A modern MRI scanner. [12] 

 

The base of an MRI is originated from a phenomenon called nuclear magnetic resonance (NMR). 

With that in mind, through this phenomenon specific magnetic fields and radio waves tend to 

cause atoms to emit tiny radio signals. Moreover, NMR spectroscopy was predominantly utilized 

as means to examine and study the composition of chemical compounds, was discovered around 

the 1930s by Felix Bloch, who was working at Stanford University at that time, and Edward 

Purcell, from Harvard University. 

 

4.2 History of Magnetic Resonance Imaging 

A medical doctor and a researcher by the name of Raymond Damadian, discovered the 

foundation of the usability of MRI as a medical diagnosis tool, around the 1970’s [18]. More 

specifically, Raymond Damadian observed that “different kinds of animal tissue emit response 

signals that vary in length, and that cancerous tissue emits response signals that last much longer 

than non-cancerous tissue” [18].  

In addition, two physicists called Peter Mansfield and Paul Lauterbur were able to develop MRI-

related techniques in the late 1970’s, earning themselves a Nobel Prize in Physiology or 

Medicine in 2003 [20]. 

https://www.radiologyinfo.org/en/info.cfm?pg=crohns-disease
https://en.wikipedia.org/wiki/Peter_Mansfield
https://en.wikipedia.org/wiki/Paul_Lauterbur
https://en.wikipedia.org/wiki/Nobel_Prize_in_Physiology_or_Medicine
https://en.wikipedia.org/wiki/Nobel_Prize_in_Physiology_or_Medicine
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From there on, the utilization of MRI was developed rapidly and the first MRI equipment was 

available at the beginning of the 1980s. Finally, “in 2002, approximately 22 000 MRI sensors 

were in use worldwide, and more than 60 million MRI examinations were performed” [18]. 

4.3 Magnetic Resonance Imaging Function 

As mentioned earlier, MRI bases its function on powerful magnetic field as well as radio 

frequency pulses and a computer to produce pictures of organs, soft tissues, bone and any other 

internals of the body. More specifically, MRI utilizes the radio signals produced by protons 

inside the nuclei of hydrogen atoms that are found in water and fat molecules in the body [18]. 

Generally speaking, during the MRI examination brief strong magnetic fields apply to the body 

and thus, changing the alignment of the poles of the hydrogen protons in the body’s tissues. 

Hence, causing the protons to emit radio signals that can be detected by the MRI machine and then, are 

being used for the 3D construction of the image.  

 

Fig 16. Detailed cross section of an MRI scanner.[13] 

The human body is constituted up to 60% of water in which the hydrogen atoms primarily are 

there and hence, this explains why the MRI use has become so widely applicable in the field of 

medicine. In fact, it is crucial to mention that there is a difference in the water concentration at 

each organ or tissues. That is the case since, there is a variety of diseases that pathologically 

change the water content and therefore, there is a unique reflection in the MRI scanner.  
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At rest the magnetic poles of hydrogen protons are randomly oriented, so when an MRI scanner applies 

the strong magnetic field to them, the hydrogen protons will reorient themselves with the magnetic field. 

Additionally, a coil is utilized in order to transmit and receive radio frequency pulses. That is the case 

since, the coil is targeting the area of the body that is to be imaged. Importantly, this transmition and 

reception of radio frequency pulses knocks the protons out of alignment. The act of shutting down the 

pulse allows the protons to return to their previous alignment with the MRI machine’s primary magnetic 

field. “As the protons return to their previous orientation, they emit their own radio signals that can be 

detected by the receiver coil” [21]. 

Through the help of advanced computer processing, it is fundamentally possible to build a three-

dimensional image from 3D volumes of tissue. The MRI machine intercepts those signals emitted by the 

3D volumes and then, they are being transformed into 2D matrices in grayscale. More specifically, these 

grayscale images derive from electromagnetic energy levels that are “assigned greyscale values and 

plotted on a 2D matrix” [21]. In fact, through this procedure is actually possible to build an image 

of a cross-sectional coronal, axial or sagittal slice of the body. Furthermore, electromagnetic energy is 

translated in to grayscale by depicting high levels of electromagnetic energy in white and the absence of 

electromagnetic energy with black. Normally, the greater the hydrogen content, the brighter the 

image. However, an MRI machines can be programmed in order to register only a certain 

direction of proton movement. Therefore, that is precisely the reason why teeth are not visible in MRI 

since, teeth do not contain hydrogen atoms and thus, they cannot be picked up by the sensor.  

 

 

Fig 17. Coronal, sagittal and axial planes 
Fig 18. side view cross-section image of the head. 

In the recent years, the utilization of MRI in the field of medicine has become more wide. With 

that in mind, some of the MRI uses include: Neuroimaging, Cardiovascular, Musculoskeletal, 

Angiography and various more. Hence, all these have their own techniques and different types of 

specialized MRIs are being used for each diagnosis. 

There are various types of MRI but the most notorious types are:  

• T1 weighted MRI  
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• T2 weighted MRI  

• FLAIR sequence MRI 

 

 
Fig 19. The same sample but deferent MR Images.[14] 

The echo time (TE) depicts the time in milliseconds between the applied radiofrequency 

excitation pulse and the peak of the signal induced in the coil. Significantly, the TE controls the 

amount of T2 relaxation. 

The repetition time (TR) represents the time in milliseconds from the applied radiofrequency 

excitation pulse to the application of the next pulse. More specifically, TR demonstrates 

precisely the amount of longitudinal magnetization that recovers between each pulse.  

T1 is when the MRI machine is programmed by experts in order to only look at the longitudinal 

movement of protons. T1 images are usually used to look at normal anatomical details and “T1 

weighting tends to have short TE and TR times” [22]. That said, T1 is the finest for looking at 

brain structure since, fat appears very bright and bone marrow contains a lot of fat.  

T2 “is the transverse movement of protons and is usually used to look at pathology because most 

tissues involved in disease tend to have a higher water content than normal” [22]. In fact,  T2 

weighting requires long TE and TR times. Additionally, T2 is best for tissue edema since, the 

water and fluids are much brighter. 

The main difference between T1 and T2 is that the “Cerebrospinal fluid (CSF) appears black in 

T1 while white in T2” [22]. Another key to remember is that in T1 the white matter appears a 

light grey where in T2 the white matter appears a dark grey. 

https://radiopaedia.org/articles/te
https://radiopaedia.org/articles/tr
https://radiopaedia.org/articles/missing?article%5Btitle%5D=new%3Ftitle%3DTE
https://radiopaedia.org/articles/missing?article%5Btitle%5D=new%3Ftitle%3DTR
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Fig 20. Major differences between T1 & T2 MR Images.[14] 

FLAIR stands for Fluid Attenuation Inversion Recovery, and aims to suppress liquid signals. 

FLAIR can be used in brain imaging in order to suppress cerebrospinal fluid (CSF) which effects 

on the image. This is the case since, the absence of CSF exposes the periventricular hyperintense 

lesions.  

MRI is the primary way to detect, monitor and evaluate Multiple sclerosis and more generally 

every central nervous system or CNS disease.  

The MRI exam poses no existing threat to the patient or animal that takes the examination. Thus, 

if proper safety measures and guidelines are taken in to account and followed, MRI is harmless. 

These safety guidelines, are a collection of rules orbiting on one basic fact, that the MRI as it’s 

name refers is magnetic. With this in mind, on an MRI exam all metal objects must be removed 

from the room in order to avoid potential injuries since, those objects will be flying fast towards 

the scanner when the MRI is activated.  

It is important to mention that, some patients must first check with their doctors before the 

examination if they have any medical devises. Of course some of them are designed to be MRI 

compatible and pose no threat like: 

• Artificial joints 

• Staples 

• Many cardiac valve replacements 

https://en.wikipedia.org/wiki/Cerebrospinal_fluid
https://www.emedicinehealth.com/anatomy_of_the_central_nervous_system/article_em.htm
https://www.emedicinehealth.com/anatomy_of_the_central_nervous_system/article_em.htm
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• Disconnected medication pumps 

• Vena cava filters 

• Brain shunt tubes for hydrocephalus [14] 

On the other hand, there are many medical devices that are out of the question because they will 

most probably end up in disaster, due to including metal in their design. Moreover, patients with 

some kind of discomfort or disease have to avoid MRI examination. Some of these conditions 

include: 

• Heart pacemaker 

• Cerebral aneurysm clip (metal clip on a blood vessel in the brain) 

• Pregnancy  

• Implanted insulin pump  

• Metal in the eye or eye socket 

• Cochlear (ear) implant for hearing impairment 

• Implanted spine stabilization rods (except newer titanium rods and plates) 

• Severe lung disease  

• Heartburn  

• Obesity (weighing more than 300 pounds may limit which machine can be used) 

• Not able to lie on your back for 30 to 60 minutes 

• Claustrophobia (which can be handled with sedation) [14] 

 

 

https://www.webmd.com/brain/rm-quiz-amazing-brain
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CHAPTER 5 

 

Workflows 

 

5.1  Introduction 

5.2 Basic Workflows  

5.3 Constructed Workflows  

 

 

5.1  Introduction 

 

Workflows in LONI PIPELINE are complete structured data flows consisted from data processing 

in between input of these data and output of the processed result. They can vary in size, complexity 

and most importantly field of research. 

 

With the modules and some of the already existed workflows provided with the LONI PIPELINE, 

a user can study existing workflows and learn from those. They can also build some out of the box 

workflows for a variety of subjects regarding neuroimaging, genomics, bioinformatics, etc. 

   

5.2 Basic Workflows  

 

As mentioned earlier LONI PIPELINE comes with some standard workflows with its installation, 

as well as some training workflows to help beginners to get to know better the platform. There are 

a sufficient number of workflows for new users to explore, as well as variety of those workflows 

for users who are looking for a workflow suiting their field of research. With that said, there are 

workflows that come with annotations to help even more the users to understand what they are 

seeing in each step of the workflow. 

 

5.2.1 AIR-BrainSuite Heterogeneous Workflow 



 

 

31 

 

One of those workflows that was easy to understand and at the same time very important is the 

AIR-BrainSuite Heterogeneous Workflow located in the Workflow/Training subsection of the 

cranium.loni.usc.edu server library. According to this workflow’s description “will showcase the 

potential for heterogeneity of image analysis tools within a Pipeline workflow. Also, it will 

present an often useful approach to putting together a workflow, in that we will take parts of 

already existing workflows and combine them in a meaningful way to perform a new type of 

analysis.” 

 

Fig 21. AIR-BrainSuite Heterogeneous Workflow 

 

The AIR-BrainSuite Heterogeneous Workflow as any other workflow begins with its input 

sources. Those input sources are two different but almost identical MRI scans which in this case 

are in .img format that need to be aligned together. 

In addition to those two 3D images, there is a third input source that provides the workflow with 

an integer number which translates to the amount of degrees of freedom. Degrees of freedom or 

DoF are the axis combined with rotation that a rigid body is free to move in three-dimensional 

space.  
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Moving away from the input sources, we find the heart of the workflow, the Align Linear module 

which is the first functional component of the workflow. This module is a general linear 

intramodality registration tool for 2D or 3D with a variety of options like:  

• 3-D models: 

o 6. rigid body 6 parameter model 

o 7. global rescale 7 parameter model 

o 9. traditional 9 parameter model (must be on AC-PC line) 

o 12. affine 12 parameter model 

o 15. perspective 15 parameter model 

• 2-D models (constrained to in-plane, no interpolation): 

o 23. 2-D rigid body 3 parameter model 

o 24. 2-D global rescale 4 parameter model 

o 25. 2-D affine/fixed determinant 5 parameter model 

o 26. 2-D affine 6 parameter model 

o 28. 2-D perspective 8 parameter model [23]. 

  

More specifically, Align Linear module in this specific workflow (Rigid Body 3D models) takes 

six inputs, the three input sources mentioned above and in addition to those, it takes three more 

inputs that are filled from the module itself. Those inputs are: threshold standard, threshold reslice 

and blur reslice.  

Align Linear module uses a variety of strategies such as cost functions, different minimization 

methods, and various sampling, smoothing, and editing to generate and deliver the final result in 

a .air format that is passed on to the next module[23]. 



 

 

33 

 

 

Figure 1. Align Linear as viewed from working surface and its parameters. Note that the three of the six inputs are already filled. 

Moving downstream we find Reslice module where the .air file from Align Linear module ends. 

Here the .air file is analyzed and a linear transformation is applied to a Volume to bring it from the 

compatible source space to the target space specified within the transform [17]. Also according to 

its information the correct image file will be loaded. With that file and the .air file a new realigned 

file is created in an AIR package consisting of .hdr and .img files [25][26].  

And with those two .hdr and .img files that Reslice module created, the Brain Surface 

Extractor module with five more inputs, removes non-brain tissue from the MRI [17]. A 

combination of anisotropic diffusion filtering, edge detection, and mathematical morphologies 

are used for this to work [17]. The final output is again passed in .hdr and .img format to the data 

sink and thus finalizing the workflow. 

 

5.2.2 Skullstriping Workflow 

 

A workflow as easy to understand as the previously mentioned is Skullstriping Workflow also 

located in the Workflow/Training subsection of the cranium.loni.usc.edu server library. This 
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workflow combines components from several packages in contrast to the previous one that was 

constructed from components only from AIR package. 

 

 

Fig 22 Skullstriping Workflow 

 

As the name suggests, this Skullstriping Workflow removes the skull from the MRI. This is done 

by using two paths, each one using a different process and in the end comparing them with each 

other to determine which one is better for each instance. 

More specifically Skullstriping Workflow takes off with its input source. Here an MRI is inserted 

by default in .img format and the workflow passes this image as .img and .hdr to both Brain Surface 

Extractor (BSE) and to a Reorient module that is needed for Brain Extraction Tool (BET). Both 

BSE and BET execute unique skullstripping algorithms and their output is channeled  

In to two FSLMaths modules from FSL (Functional Structural Library) Package. The difference 

from one FSLMaths module to the other is that in the first one generates a tightly skullstripped 

result and the other more tolerant one. This is achieved by intersecting the whole-brain masks 

generated from the previous modules in the tight one and uniting the masks for the tolerant one. 
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Both of the FSLMaths modules that each one represents the tightly skullstripped and tolerant 

skullstripped end up in two data sinks named after each algorithm. There the user can view the 

results of each algorithm and choose the one that suits best for each instance or compare the one 

with the other. 

 

5.3  Constructed Workflows 

 

Based on the information gained by the already existing workflows and by browsing the modules 

in the libraries of LONI Pipeline, a workflow was constructed with the primary goal of MRI 

registration. This constructed workflow is based on AIR-BrainSuite Heterogeneous workflow 

due its primary function on image registration. 

 

 

Fig 23 Constructed Workflow 

  

This workflow as any other workflow begins with its input sources which in this particular one are 

five, the four instances of identical in format MRI scans and the input containing the Degrees of 

freedom or DoF. 
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Moving away from the input sources and where there should be Align Linear module, there is an 

extra module called dcm2img before Align Linear module. This is because in this particular 

workflow the data we are using are dicom format and the workflow is set up to accept .img data 

and a conversion is needed.  

After the conversion there is the Align Linear module which functions the same as AIR-

BrainSuite Heterogeneous workflow and so we move to Reslice module where the .air file from 

Align Linear module ends. 

By the end of the Reslice module where we would expect a data sink instead we find again Align 

Linear module that takes this output as input as also the output of the another Align Linear 

module where other two MRI were registered. 

This is the final registration in this workflow. The output of this Align Linear module goes thru 

a Smartline Converter and then ends un in a data sink. 

In other words, four MRIs are divided in to two groups, where the first two are registered together 

into one. At the same time the other two registered together into other one and those two are 

registered together in the end. 
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CHAPTER 6 

 

Conclusions and Future Work 

 

6.1  Conclusions 

6.2 Future Work  

 

 

6.1  Conclusions 

 

LONI Pipeline is a diverse tool, aimed to help researchers, scholars, doctors, MRI specialists and 

all kinds of people focused or involved in the medical sector. But as diverse the tool aims to be, 

jack of all trades can be master of some. 

The tool as helpful the GUI is in helping and welcoming a newcomer it is lacking some is some 

areas. As it is easy on first glance to navigate and find what you are looking in firsts tutorials and 

basic workflow, it is getting harder in each iteration that the user is looking for something more 

precise for his work. 

As for the work intended to be produced by the analyzing and building of some workflows was 

very frustrating and at some point none existing due to the tools inconsistent provider of data 

translations to fit its modules that are some build for specific data types on input and output.  

In addition to the previously mentioned issues, LONI Pipeline offers on download a tool called 

LONI viewer that as the name applies it views the outcome of the workflow as a whole 3D image. 

The issue with this is that if it is able to launch where the majority of times it does nothing it views 

a blurred image that little to none conclusion may have extracted from the workflow in review.  
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Fig 24 instance of a result as seen from LONI viewer. 

 

To sum up the previously mentioned, in my point of view LONI Pipeline is not the ideal tool for 

the intended purpose of this thesis hence little can be extracted from the workflows and the data 

appointed to it. It may be extraordinary tool for other purposes and tasks as long as skilled and 

experienced people use this tool in an extend the itself allows it.  
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6.2 Future Work  

 

As the result of the LONI Pipeline where not clear enough and the end result is still unclear, for 

future work might be in the form of tool shift. There are multiple tools in existence that can be 

swapped with LONI Pipeline as also am confident that even more are in process of been created   

As per the task indeed to be done a fitting tool might be KNIME Analytics Platform that as it is 

also aimed for vast spectrum of purposes and not just MRI manipulation tool. Never the less it is 

used from specialists on almost similar tasks although it does not provide the eye candy GUI that 

LONI Pipeline provides it may me more appropriate for this type of tasks. 

So in conclusion the way to go for future work has to exploring new tools for this task, with priority 

given to KNIME Analytics Platform. As also apply knowledge gained from the previous tools 

and trials for going thru better test that end up in clear results.  
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APPENDIX A 

 

LONI PIPELINE 

 

A.1  Introduction 

A.2 Installation 

A.3 Interface Overview 

A.4 Workflow Building 

A.5 Execution 

 
 

A.1  Introduction 

“The LONI Pipeline is a free workflow application primarily aimed at computational scientists. 

With the LONI Pipeline, users can quickly create workflows that take advantage of all the 

greatest tools available in neuroimaging, genomics, bioinformatics, etc.” [15]. Furthermore, with 

LONI Pipeline we can create, validate and execute a data analysis neuroimaging, as also we have 

the capability of automated data transformation, the net usage, ease of data input and a vast 

collection of computing tools.  

In contrast with other graphical analysis architectures, LONI Pipeline offers two major 

advantages, the distributed Grid computing environment which allows of a more efficient jobs 

completion, jobs validation and it has permits efficient tool integration, protocol validation and 

broad resource distribution [16]. 

 For the integration of existing data and computational tools within the LONI Pipeline 

environment there is no need for a modification of the resources themselves. The LONI Pipeline 

environment provides us with various types of process submissions based on the underlying 

server hardware infrastructure [16]. The only data stored within the LONI Pipelines environment 

are workflow instructions and references to data, executable scripts and binary instructions. Thus 

“making it portable, computationally efficient, distributed and independent of the individual 

binary processes involved in pipeline data-analysis workflows.” [16]. 

In summary, LONI Pipeline is a workflow application allowing the execution of any executable 

for use in this environment. Does not require any change to our programs such as 

implementation of code or interfaces, for the usage of these programs inside of LONI Pipeline. 

We are ready to use LONI Pipeline with ease from the graphical interface or we must understand 

sufficiently the usage of the command line which is a somewhat more complicated.  
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A.2 Installation 

A.2.1 Requirements  

LONI Pipeline client requires an installation of JRE 1.6 or higher 

(https://www.java.com/en/download/) from Oracle. For Linux, java may be installed by default 

although it may not be Oracle’s version. “To check which version of java you are running, under 

terminal, type java -version. If you did not see something like “Java HotSpot(TM)”, then you 

need to download and install Java from Oracle” [17].  Furthermore, LONI Pipeline does not 

require large amounts of memory, so RAM is not an issue. 

A.2.2  Downloading  

Downloading LONI Pipeline is a strait forward procedure. You’ll have to go to Pipeline website 

(http://pipeline.loni.usc.edu/ ) click on the Get Started -> Download link in the navigation bar at 

the top. 

A.2.3  Setup and Launch  

Setup and Launch varies from operational system(OS) to another, so we’ll have to analyze them 

individually 

For installing on Windows OS, you’ll have to double-click the installer and follow the on-screen 

instruction. Once it finishes installing, you can close the installer and launch the program by 

going to the Start menu->Programs->LONI Pipeline and start the program. 

For installing on OS X (MAC OS), you’ll have to double click the disk image file you 

downloaded, and drag the LONI Pipeline application into the Applications folder. Once the 

program is done copying you can unmount (eject) the disk image and move it in the trash. To 

start the Pipeline, just go to your Applications folder and double-click on the LONI Pipeline 

application. 

For installing on Linux/Unix), you’ll have to extract the contents of the file to a file located on 

disk, and execute the PipelineGUI script. Note that you’ll have to make sure to have the java 

binary in your path. 

A.3  Interface Overview 

A.3.1  Server library 

On first launch of LONI Pipeline you’ll notice the area to the left is empty. This is because here 

is the server library where you can see a list of all the modules available to you when you 

https://www.java.com/en/download/
http://pipeline.loni.usc.edu/
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connect to different servers and therefore because it’s the first time, it is empty. When connected 

to a server here you will see the tools you have access to. 

For gaining access to the tools LONI Pipeline, you’ll have to log in with your username and 

password which you’ll need to obtain from Pipeline server apply for an account. After receiving 

your credentials, you can connect to the server (cranium.loni.usc.edu) and be able to see the tools 

available on the server in the library. Server library supports workflows from multiple servers. 

 

Fig 25. Server Library browser structure 

Library items have some extra functionalities in the library. They can be sorted “by Module 

Type” or “by Server address”, manually connect by right clicking and call Update library 

function which will automatically connect to servers included in your current server library and 

update the Server Library Content on your local computer. You can search the server library by 

keyword, and it will return matched result ranked by popularity [17]. If the library is empty due 

to removing library content and run Update library command, Pipeline will check for your 

current connections and will update only from servers you are connected to. 
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While you are not connected to a Pipeline server, server library will still display the list of tools 

as they are cashed to your computer, enabling you to build workflows even while offline. 

A.3.2  Personal library 

Personal library is located in ‘Window->Personal Library’ and it is here where your workflows 

and personal created modules are stored. Therefore, by selecting a directory or use the default 

directory from preferences you can save all the personal workflows and modules there. That said, 

you can visit your personal library whenever you want to see your modules and workflows or, 

you can drag a module in an open workflow with ease.   

 

Fig 26.Personal Library with nothing saved in it. 

 

LONI Pipeline also allows workflows to be opened or saved to or from to Personal library by the 

following path.  

Save: Click File -> Save To -> Personal library 

Open: File -> Open From -> Personal library 

Personal library is very similar to server library as it can be used with the same way to construct 

workflows. “If you have defined lots of modules that describe executables on your local 
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computer or even module groups, you can drag in copies of them to create even more 

sophisticated workflows.” [17] 

A.3.3  Workflow Area 

The largest area of the interface of LONI Pipeline is the workflow area where you can open or 

start a workflow by selecting either of the two buttons at the center. In addition, there is a list of 

the recently opened workflows if there is any for ease of access.  

 

On the workflow area you can open multiple workflows at the same time by utilizing tabs or 

windows. Just like browser tabs, these tabs can be dragged and dropped to generate a new 

window, rearranged by the user or closed by clicking the cross icon for the tab. “You can also 

move over the tab that is not in current view, it will show you a small overview of the workflow” 

[17]. 

A.3.4  Connection Manager 
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By default, LONI Pipeline has the cranium.loni.usc.edu server as saved connections, but 

nevertheless you might want to connect to deferent servers to get access to their tools. Therefore, 

to view the list of connections, you’ll have to go to ‘Window -> Connections’ or click on the 

disconnected circles at the bottom right of the window and a menu will pop up which you’ll have 

to click on connections. 

 

As mention earlier Pipeline has LONI server as a default but you’ll have to apply for an account 

to connect with it and use it.” You can click Edit and put your LONI username, and then click 

Save. Once you’ve entered the connection, go ahead and click ‘Connect’. After 30 seconds or so 

you’ll notice that your server library has been populated with tools from the server.” [17] 

Moreover, you can add a new connection to any pipeline server by clicking New.  

A.3.5  Preferences 

Preferences are partitioned in to various tabs like General Tab, User Tab, etc. which each one has 

its corresponding preferences settings. However, for OS to OS varies in to the procedure of 

bringing up the preference menu: 
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OS X: Go to the ‘LONI Pipeline’ menu and select ‘Preferences.’ 

Windows: Go to ‘Tools’->’Options’ 

Linux/Unix: Go to ‘Edit’->’Preferences’ [17] 

 

In General Tab we can view and change: 

• Personal Library (where your library of workflows and personally created modules are 

stored). 

• Automatically check for available updates (if checked, Pipeline will check for update 

every time it starts). 

• Animate Server Library (if selected, server library will hide automatically when 

workflow is executing, and will show up automatically when workflow is stopped). 

• Enable Smartline when designing workflows (If enabled, Pipeline will create translation 

module between image files automatically when making connections) [17]. 

In User Tab we can view and change authors information, in other words it will automatically 

apply to the “Module Described by” field for the module you created [17]. 
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In Cache Tab we can view and change the execution cache directory and library module cache. 

“The execution cache directory is where all intermediate data is written to while executing a 

workflow and the library module cache can be cleared here” [17]. 

 

In Local Execution Tab we can view and change the Maximum simultaneous jobs, Use Grid 

Plugin and Environment Variables for your local execution. Maximum simultaneous jobs are the 

upper limit of the jobs running in parallel that are ready to submit at once, when this number is 

reached, the other jobs will be queued up until other ones complete. Use Grid Plugin, “if you 

have a grid manager locally, checking this will enable your local workflows sent to the grid 

manager” [17]. a specification has to be made for grid plugin jar file path and the class name. 
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In Server Tab you can set up specific preferences to a Pipeline server such as, email notification 

about various workflow states. To view or edit this you’ll have to connect to the server since, this 

setting is synchronized to the Pipeline server. “Once you clicked Apply, the changes will take 

effect to all your workflows on that server” [17]. 

 

A.3.6  Search Feature 

The Search feature allows the user to query for modules in Library and Personal Library panels 

and it will return “results drawn from the module’s name, author list, citations, tags, description, 

and parameter fields” [17]. 
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A.3.7 Checking for latest updates 

Although Pipeline will inform you if there is a newer version available, you can check if you 

have the latest version of the LONI Pipeline client in the Help Menu by clicking on ‘Check for 

Updates’. From there on you can download and install it if there is any newer version by simply 

following the instructions. 

 

A.4 Workflow Building 

A.4.1  Dragging in modules 

Modules located either in personal or server collection can be dragged and dropped on to the 

workflow area. Furthermore, all modules that are used in a workflow have to be from the same 

server or local libraries or a pair of a remote server and your local machine. “For example, you 

can mix modules from the LONI Pipeline server and your local machine, but you cannot mix 

modules from the LONI Pipeline server and modules from the Acme Pipeline server” [17]. 

A.4.2  Connecting modules 

 

Modules in a workflow can have more than one inputs and outputs and they need to be connected 

with other modules. However, when an attempt is made to connect two modules Pipeline does 

some initial checking to make sure the connection is valid. Connections that are not valid such as 

a file type parameter to a number type parameter, or connecting an output to another output and 

more. Pipeline also “supports the connection of a single output parameter to multiple input 

parameters, as well as the connection of multiple output parameters to a single input parameter “ 

[17]. 

When connecting two module Smartline may be appear. “Smartline is an automatic file conversion 

tool which based on information about input and output, a Smartline will take care of any file 

translation needed” [17]. 
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A.4.3  Setting parameter values 

 

A module in a workflow as mentioned above has inputs and outputs. Modules can be inputs for 

other modules as well as input parameters and data inputs which we will see later. Parameters can 

be enabled or disabled depending on the scope of the workflow and the module itself. Modules 

come with their default parameters found in a list like interface by Right click-> Parameters tab. 

Here also you can change the Parameters setting as well as add more parameters to the module as 

seen below  

 

Data for these parameters can be mixed from local (located on your personal computer) and remote 
(from server), and Pipeline will manage the data accordingly for the user. As LONI’s website 
describes an example “the input to the ‘Align Linear’ could be located on your local drive, but you 
could set the output of the ‘Reslice AIR’ to be written to some location on the Pipeline server or vice 
versa” [17].  

A.4.4  Data sources and data sinks 
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Every workflow needs some sort of input of data and an output repository, this is where you can 

take advantage of sources and sinks. Therefore, by right-click on any blank space in the 

workflow area and select New > Data source a new window will appear and a data course icon 

will be placed on the workflow area. This window has two tabs the ‘Inputs’ and ‘Browse’ tab. In 

inputs tab you can enter some information about the data source and on brows tab you can 

browse and select multiple files into the list, or you can just type in the path to a file manually. In 

addition, in brows tab there “an option for a server in case you want the data source to represent 

data on another computer” [17]. 

With that in mind, data sinks work pretty much the same way only in reverse. Therefore, by 

right-click on any blank space in the workflow area and select New > Data sink a new window 

will appear and a data sink icon will be placed on the workflow area. Here, you can specify the 

output filenames and location in a data sink and connect to the output of the module, the file will 

be generated specifically on that destination. Files in data sinks are not copied over from 

temporary directories, but rather generated directly on execution time.” If no data sink is 

specified, output files will be in the temporary directory, with system generated filenames” [17]. 

Data sinks also enables you to specify a target directory without point out each file individually 

by selecting Directory Source and specify desired directory. Moreover, you can insert filters so 

that only filenames inside the directory that meet the filter will be included, the same can be done 

with file types, which filter based on file extensions. 

A.4.6  Adding Metadata 

 

Inside any regular data source there is an option to ‘Add metadata’ and enhances the data source 

functionality, allowing the fusion of imaging data and non-imaging meta-data together, enable 

queries groupings, and construct study-designs based on user-specified criteria. Moreover, two 

new tabs will appear next to the Input Tab. Metadata can be inspected for any module’s output 

under the module output files panel. 

Metadata as well as image data are propagated to subsequent modules all over the pipeline 

workflow in data-metadata pairs generated by the application. That said, metadata can be read and 

fed to any module (Data Extraction), and values produced by any module can be added back to the 

metadata (Metadata Augmentation). “The metadata information may be represented as an XML 

file, as long as it’s schema is valid (well-formed) and consistent (uniform for every subject in the 

study), or as a tabular spreadsheet (CVS)” [17]. 

A.5 Execution 

 

A.5.1  Validation 
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When successfully building a workflow and proceed to execute it by pressing the button on the 

screen under the workflow area. LONI Pipeline firstly goes thru validation of the whole workflow 

to check for errors and warnings while showing ‘Validating’ status to the user. Moreover, LONI 

Pipeline can validate a workflow without executing it by going to Execution->Validate, and 

validation will automatically begin. For validation as well as execution a connection with a 

Pipeline server is essential, so if a user is not connected Pipeline will prompt you for a username 

and password. Finally, if any warnings or errors are found during validation a dialog will pop up 

listing all the errors found in the workflow [17].  

 

A.5.2  Executing a workflow 

For executing the workflow, it’s the same procedure as the validation phase, after all a validation 

must be done prequel to the execution as mentioned earlier. That said, by pressing the ‘Play’ button 

located on the bottom of the screen, beneath the workflow area. The program will initiate the 

execution (validation first) except if the user is not connected to a server where Pipeline will 

prompt for a username and password.” Once all necessary connections have been made and 

validation has completed the workflow will begin to execute.” [17]. 

LONI Pipeline has various types of statuses for each module indicated next to each one, depending 

on traffic the Pipeline handles at the moment and the result of the execution. These statuses show 

detailed information about each module. Note that more than one may be indicated. These statuses 

are:  

• Initializing – Appears when instance is preparing for submission 

• Queued – Appears when instance already submitted the job and it is on the queue 

• Running – Appears when job starts execution 

• Complete – Appears when this module finishes executing successfully 

• Error – Appears when this module has error(s). Since version 4.2, Pipeline will continue 

to run whole workflow execution for succeeded instances after marking failed instances. 

• Backlogged – Appears when maximum job count has been reached for current server and 

the server temporary blocked the instance until new slots available 

• Staging – Appears when transferring files to/from server from/to localhost 

• Incomplete – Appears when module has finished its execution and some instances failed 

• Cancelled – Appears when parents of current module failed and continuation of current 

module became pointless 

• Paused – Appears when user pauses a running workflow. All running modules and their 

successor will be paused [17]. 
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By hovering the mouse above the module, a popup box will appear and more detailed status 

information about each job for that module are also shown. Moreover, this information can be 

found in the execution logs, which can be opened by clicking a module and clicking on ‘View 

Execution Info’. 

LONI Pipeline estimates the runtime of each individual job on the grid depending on the modules 

and workflow by comparing them with similar jobs that ran in the past. By calculating the runtime 

for each module, it can conclude to an estimated runtime for the whole workflow. Moreover, it 

takes in to consideration instances, currently available grid resources, and other factors. To view 

this information, the user hat to move the mouse above the module for the modules instance 

estimate and move the mouse above lower left corner where workflow runtime is displayed. 

A.5.3  Client disconnect/reconnect 

When the workflow successfully passes from the validation to execution, due to it is running on 

a Pipeline server therefore, it is independent from the user’s computer. The user can shut down 

their computer or quit LONI Pipeline no matter what the workflow will be still running on the 

server until it’s completion or in the event the user presses Stop. Therefore, to view executed 

workflows start up the Pipeline client and use the Connection Manager to connect to the server 

where the workflow was running on. Moreover, at “Window -> Active Sessions on the top menu, 

a dialog with a list of all active workflows will pop up and there the file name of the workflow, 

start time, finish time is visible (if it’s still running, it will show “Running”)” [17]. By selecting 

and reconnecting on any of the workflows, the workflow will open with the latest status on the 

workflow area. 

Workflows can be removed from Active Sessions list manually or after the past of fifteen days.  

A.5.4  Server Status 

 

When the workflows are initiated then, the workflow is submitted to the Pipeline server and queued 

up and therefore, the Pipeline server responses the information about the status of the server. More 

specifically, this information includes the total slots of the server, the traffic on the server, jobs 

that are queued up, and jobs executed on the server. In fact, the above information is displayed at 

the bottom right corner of Pipeline window.  

 

A.5.5  Pausing a workflow 
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When pausing the workflow while it is working by pressing the ‘Pause’ button, it will stop all 

running jobs/instances and all their output files will be deleted. However, output from completed 

jobs will be kept. The workflow can resume by pressing the ‘Play’ button. 

 

A.5.6  Restart a module 

 

Each completed or erroneous module can be restarted by pressing on the completed module and 

select ‘Restart Module’. Another way to do so is by opening the Execution Logs on the module 

and press the ‘Restart Module’ under the Info tab. More specifically, for the restarting module and 

its successor modules, all instances and jobs will be resubmitted to run. Finally, their output files 

will be deleted in order to avoid any possible conflict on subsequent run. 

 

A.5.7  Viewing output 

As the workflow proceeds and executes modules, the user can view the output and error streams 

of any completed module. By going to ‘Window->Log Viewer’ or by pressing on the module and 

click on ‘Execution Logs ’to bring up the log viewer and view information about it. Furthermore, 

in the left column of the log viewer the user can select the instance of the module that wants to 

view their output.  

The execution info window, not only displays status information but also a variety of additional 

job information such as the server that it runs on, its running time, job and session ID’s, and 

command string. More specifically, session ID is a unique ID to all active workflows and its used 

with your workflow’s name for ease of access and reconnection to a specific workflow. 

The output and error logs are very helpful in in debugging failed jobs and they are located in 

synonymous tabs that contain data that are captured by the application’s output and the error 

streams, respectively. That said, information from the error stream and output can be viewed 

through a variety of tools that determine the reason why the job lead to failure. 

The output files tab is consisted by a list of all files that are created by that instance of the module. 

Here you can view them by pressing ‘View data’ or download them by pressing ‘Download’ to 

your system. 

A.5.8  Debugging execution 
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Subsequently, in some of the instances the module will end up failing and they there will be a red  

ring around it. Therefore, by using the log viewer and view the failed incenses or jobs of the module 

highlighted in red and with help from the output and error stream all problems should be diagnosed. 

 


